
19      What’s New in 3.6?
 
New features have dribbled into LiveMath 
over the past decade(s). With this new 
LiveMath 3.6, we here highlight some of 
the new features to look out for in this 
minor update version.

.6

19.1  	LiveMath Plug-In is Retired 
	 .....    Long Live LiveMath Viewer!

With some regrets, LiveMath Plug-In has been retired.

The overall problem with plug-ins is the new (and it is about time!) 
focus on browser security.  Plug-ins, by their very nature, are programs 
in their own right that could be doing some very nasty things to your 
computer once installed, as can happen when installing any program.   

The browsers have really clamped down on security, as you can see 
from the near weekly updates of Flash and Java, and their frequent 
disabling by Apple and Microsoft.

The “Netscape Plug-in API” has never been updated since 1998.   It 
is horrible.  The LiveMath Plug-In was continually in a “let’s try this 
example over here” to try to get it to work, and it never really did very 
well.  With every new browser release of Firefox, Chrome, and Safari, 
the LiveMath Plug-In would break.  We just couldn’t keep up with the 
maintenance required.

On the Windows side there are 2 plugins, of course:  the Active-X 
control for Internet Explorer, now Edge on Windows 10, and the 
Netscape-based plugin for all of the other browsers (that support 
plugins).  

On the Mac side, the browsers all made their move to 64-bit-based 
binaries, and LiveMath is still built upon the older 32-bit technologies 
(QuickDraw).   So that just in and of itself sunk the Mac side.
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The commerical side of LiveMath Plug-In never materialized, either.  
We made a lot of “textbook websites” for various publishers over 
the initial years of LiveMath Plug-In, but that development did not 
continue.  We had “Viewer-type” restrictions in LiveMath Plug-In 
which allowed you to interact with preset equations and computations 
and graphs to achieve the “LiveExample” goal.   Yet, aside from us and 
a few academics, few used the LiveMath Plug-In.  

You may achieve essentially the same functionality of LiveMath Plug-
In via the external (free) program LiveMath Viewer, which has the 
same reduced functionality of LiveMath Plug-In.

LiveMath Viewer

Instead of “viewing” (and interacting with) a LiveMath notebook 
inside of a web browser, you will now simply launch that same note-
book from the webpage into LiveMath Viewer instead.

Like LiveMath Plug-In, LiveMath Viewer cannot save changes to a 
LiveMath notebook file, nor may you copy/paste items out of the 
notebook via LiveMath Viewer.  You may do the following via Live-
Math Viewer:

•  Interact with Graphs 
Spin and explore graphs, change inputs/variables etc.

•  Change Assumptions on Existing Calculations 
With a notebook created in LiveMath Maker with a 
certain set of calculations, you may change the inputs 
(Assumptions) of those calculations, and see the com-
putations (Conclusions) recalculate based upon the 
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changed inputs.

3 x 2 5 x− 6+ 0=
3 x 5

6− 1
6 47 i+ x 5

6− 1
6 47 i− 0=  Factor

x 5
6

1
6 47 i−=  Isolate

x 5
6

1
6 47 i+=  Isolate

May change in LiveMath Viewer

May NOT change in LiveMath Viewer

The main restrictions of LiveMath Viewer are:

•  No Saving of Notebook Changes
•  No New Calculations Added
•  No New Objects Added

 
You may say, “Awe!  That’s terrible!  I should be able to do these 
things!”.   You can.  Just get LiveMath Maker.

You may have to teach your web browser what to do with “.thp” - files 
associated to the former LiveMath Plug-In:  you need to teach your 
web browser to use LiveMath Viewer to open those files as an external 
application (unless, of course, you have LiveMath Maker).

So, for a web presence for LiveMath, we will return to links from 
webpages into LiveMath Maker.  You can “teach” the web browser 
to launch LiveMath when you try to open a “.the” file - and you may 
reteach the browsers to do the same for the formerly Plug-In files with 
“.thp” file extensions. 
 
In this simple webpage example, we have a hyperlink to a “.thp” file:



§ 19.1  	 LiveMath Plug-In is Retired 	 .....    Long Live LiveMath Viewer! 	  Page 603 

© 1999-2017 MathMonkeys, LLC.  © 1999-2017 Robert R. Curtis

The URL to the actual file is:
 

http://www.livemath.com/viewer/LMVExample1.thp

When you click on that link, Firefox (or your web browser) will then 
ask you what it should do with these “.thp” files:

You should click on the “Open With” radio button, then click Choose... 
and then navigate to the LiveMath Viewer application in your Applica-
tions or Program Files directory:



The LiveMath Book	 Page 604  

© 1999-2017  MathMonkeys, LLC.  All rights reserved.  Some rights a bit wild. 

Clicking on the LiveMathViewer application and then click Open, you 
will then see this dialog box from Firefox:

And finally, clicking OK now will launch the notebook into LiveMath 
Viewer:

Thus resulting in the notebook being opened by LiveMath Viewer:
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19.2  Larger Palette

Screencast Video
http://www.livemath.com/v/1902

Way back in the year 2000, the LiveMath palette seemed enormous 
with a width of 500 pixels.  “It’s too big” many screamed!  The deluxe 
screensize of the day was a whopping 640x480 pixels.

Fast-forward to 2017 and screens are commonly 1500-2000 pixels 
wide and beyond;  the smaller icons just don’t fit the bill.

Some like the smaller button size, as they may only use the palette 
once in a while.  But others, especially on Windows 10 and its crazy 
way it deals with screen resolution (dpi), a larger palette option is 
required.

While a stretchable palette is not possible given the older technology 
on both the Mac and Windows sides,  we did a simple double enlarge-
ment to the new Large Palette options, with the width of the palette 
now at 1000 pixels:

Small Full Palette:  500 pixels wide

Large Full Palette:  1000 pixels wide

The Large palettes also use a new version of the artwork:  vector-based 
artwork that was commissioned for LiveMath 4.0, but I stole it over 
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for this intermediate LiveMath 3.6 release, mainly because the older 
artwork was not in vector format, so it could not be enlarged.

Both the Full and Skinny palette options remain, so now there are 4 
palette options:

		  (Small) Full Palette
		  (Small) Skinny Palette
		  Large Full Palette 
		  Large Skinny Palette

The small palette is (primarily) made of buttons that are 24x24 pixels.  
The new larger palette is (primarily) made of buttons that are 48x48 
pixels.

Remember you may hold the mouse over a button, and then hold down 
the Mac: B or Win: C keys to have a text help bubble appear 
that describes the button.

19.3  New Menus

Screencast Video
http://www.livemath.com/v/1903

A new feature of LiveMath 3.6 is a redesigned menu structure. 

The new menus are yet another feature stolen from the LiveMath 4.0 
development, as I just got sick of using the old LiveMath 3.5 menus.

On the Mac side, we have new graphical feature:  menus commands 
that correspond to palette buttons have those palette buttons in the 
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menu.  Maybe these menu icons will get into the Windows version in a 
future update, but for now this is a Mac-only version.

Let’s take a look at the new menus.

File Menu

The File Menu is nearly unchanged, with the exception of 
Show Page Breaks, which is explained in §19.8.

Edit Menu

In addition to the menu icons, the Edit menu has been cleaned up.  Of 
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significance are the new features:

• 	 Copy for PrintMath
You may select an object in LiveMath, use Copy for 
PrintMath, and then go over to PrintMath and paste 
- if the object is something that PrintMath can handle 
(and work with), like integrals and math expressions, it 
will take the paste and you can edit.   If you try this with 
a graph or something similar, then of course PrintMath 
does not know how to deal with this.

• 	 Export Formats
This new feature is discussed at length in §19.4 below. 

• 	 Comment Back Color
Each comment may have a background color.   Due 
to limitations of original design (going back to 
Expressionist 30 years ago), we cannot back color indi-
vidual subobjects (words or math expressions inside of 
comments).   

A nice comment
A nicer comment with a bright background

• 	 Propositions Tree
This was moved from the old Notebook menu over to 
here.  Seems more natural here.  This menu allows you 
to move propositions to different parts of the notebook 
tree.  Usually you indent via dragging objects in the 
notebook tree.

Notebook Menu
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The old Formatting menu has been removed, and the two main items 
in that former menu, Set Font Math and Comment Prefs, are now 
on the main level of the menu.  Otherwise this menu has not changed.

Insert Menu

This menu is entirely new.  The goal of this menu is to address the 
age-old question, “but how do I get that in there?”  Many of these 
items are available in the Palette, some were inserted via special (and 
not well documented) keystrokes. Over the years in working with 
novice LiveMath users, it became clear that a central menu location 
was required that held all of the possible inputs into LiveMath.

Likely you will not use this Insert menu as the primary insertion 
method, but rather you will continue to use the Palette and/or 
keystrokes.   But when you get to the need to insert something, and 
you forget where in the Palette it is located, or you are working with a 
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novice user, or forget which keystroke does the insert, this Insert menu 
will be very helpful.  The keystrokes are shown in the menu when there 
are keystrokes for a specific command.

The Insert ▶ Statement submenu has the two most common 
entry options:  New Math Assumption and New Text Comment.  
It is unlikely you would use these menu options to get either new 
objects into a notebook, but for novices just starting out who often get 
confused about the different between a Math Assumption and a Text 
Comment, well, there they are.  With the keystroke reminders as well.  

Insert ▶ Basic Operations submenu is rather obvious not needing 
explanation:

Insert ▶ Graph Primitives submenu is a menu version of the 
Graphics Primitives collapsar inside of every New Notebook, for the 
purpose of getting a blank graphics primitive into the notebook, for 
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those (like me) that like to build up your graphs manually, without all 
of the entry processes of the Graph menu.

If the current selection is inside of a Graph Theory (2D or 3D), then 
any of these menu options will insert a new graphics primitive into that 
theory (even another graph, so beeeeeeee careful!).   

If the current selection is outside of a Graph Theory, these menus will 
insert the chosen graphics primitive, but outside of a graph theory, the 
SurfaceAt primitive will not do much (anything).

 Surface at ?? where ?? and ??; April Lighting  surface has mesh  and is shaded using 
Solid  coloring;

White  is the solid color.

No graph theory

The slots for any of these graphics primitives are blank, so you have to 
do all of the work to bring life to them inside of a graph theory:
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LiveMath Graph Alert:  Graph in
process of changing.  Maybe you are
not finished typing?  Please finish
typing/entering, then CLICK on this
Graph to REDRAW.  For now,
LiveMath cannot draw this graph: A
range specification must be of the
form: 
variable = a...b.

??

  3− 3...  = west...east Stretch to Fit
  3− 3...  = south...north     cropped 

Moderately
  3− 3...  = bottom...top     as seen through a 

Normal  lens

Graph Building Blocks
 Surface at ?? where ?? and ??; April Lighting

 surface has mesh  and is shaded using 
Solid  coloring;

White  is the solid color.

Manually entering the (correctly formatted) data, you can then custom-
ize your surface:

0.60.4-0.6 0.2x-0.4 -0.2

-0.6
z
-0.4

-0.2
00

0

0.2

0.4

0.6

0.2 0.4-0.2 0.6-0.4y-0.6

  0.75− 0.75...  = west...east Stretch to Fit
  0.75− 0.75...  = south...north     cropped 

Moderately
  0.75− 0.75...

 = bottom...top     as seen through a Normal  lens

Graph Building Blocks
 Surface at s t 3 t s− s 2 t, ,  where 
t 1− 1...=  and s 1− 1...= ; 
April Lighting  surface has mesh

 and is shaded using Solid  coloring;
White  is the solid color.

The Insert ▶ Lower Greek and Insert ▶ Upper Greek are 
self-explanatory, with the Mac: W or  Win: a keystrokes.   
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The easiest keystrokes for greeks are the apostrophe-based keystrokes: 
Z‘  a = α

Likewise Insert ▶ Symbol is self-explanatory, giving the miscel-
laneous symbols available in LiveMath.   

The Insert ▶ Wildcards gives a visual description of the different 
types of wildcard variables.  These are for advanced users of LiveMath 
who are doing Transform rule programming.  But, of course, wildcard 
variables are used for defining simple functions, too.  The keystrokes 

?X are not shown, as these are too specialized to get into the 
menus as we would want to show them.  (Mac does not consider ?a as 
a keystroke, although it is to LiveMath).

The next insert menus:  
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are all self-explanatory.   

The last submenu, Insert ▶ Comment Extras, are inserts that only 
work in the comments:

These are constructions that only work inside of the Text Comments, 
and are borrowed from PrintMath.   The Block is the most useful in 
the text comments for building up a complicated object (that may or 
may not have any mathematical meaning, but certainly does not have 
support inside of LiveMath for calculation purposes)
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B?

?

?

?

?

?

B3

2

4

1

5

6

In general, the other mathematical object inserts work for both math 
computational areas, or in text comments, inserting the different 
objects appropriately:

? d?
??

?

?
?

?

Compute Menu

The Compute menu has been reorganized, with the goal of greater 
simplicity.   It is a big menu, and I almost split it into 2 menus, but 
there didn’t seem to be a natural separation point to do that.  So, 1 big 
menu it is.
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The Solve Numerically options is a menu command that is still under 
development, and will appear in a future minor release.

The Macros areas are the computations that are “multi-step”, as 
described in §19.11.

Graph Menu

The Graph Menu is largely unchanged in LM 3.6, although there is one 
addition in the Graph ▶ Graph 3D menu with graphing a Parametric 
Surface via the menu command on a selected 3-vector with 2 indepen-
dent variables, 1 dependent variable (Matrix variable):
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This will trigger a variable match-up dialog:

and voilà:  
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10-10x

-10
z-5
0

00

5

10

y 10-10

  18− 18...  = west...east Stretch to Fit
  18− 18...  = south...north     cropped Wide
  12− 12...  = bottom...top     as seen through a 

Slight Telephoto  lens

Graph Building Blocks
 Surface at T  where s west east...=  and 
t south north...= ; April Lighting
 surface has mesh  and is shaded using 
Solid  coloring;

White  is the solid color.

Examples and Help Menus

These menus have not changed, although some references to LiveMath 
Plug-In, which is now retired, have been removed.

19.4  Copy/Save as PDF & PostScript

Screencast Video
http://www.livemath.com/v/1904

Nearly 6 years ago, during a “hack attack”, I wrote a little converter 
to take our wonderful PostScript output of all things in LiveMath 
(and PrintMath), and convert it to PDF using a nice little Apple API 
function I found.  (It is the same function that Preview uses when you 
double-click on a PostScript .ps file, converting it to PDF, which is the 
Mac’s “natural” graphics format since OSX).   
This little feature lay dormant in the source codes until now.  Better 
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late than never I suppose.

You may now highlight objects in a LiveMath notebook, and select:

and you get into the Clipboard the beautiful PostScript-quality PDF 
output for pasting into other programs like Microsoft Word, or Adobe 
InDesign, which is the layout program this The LiveMath Book is writ-
ten in.  So you can see the quality of this output method in this book.  

Note the keystroke:   WUc It comes in very handy.

You may also Save selections out to PDF files, or copy/save the raw 
PostScript (PS) data.

The Copy As PDF options are only available on the Mac side.  I have 
to write the cross-platform PDF writer, which is under development, 
and will appear on the Windows and Linux versions in a future minor 
release.

19.5  Copy/Save from PrintMath

Screencast Video
http://www.livemath.com/v/1905

If you have more complicated math expressions you wish to have in 
Text Comments, you may use PrintMath to create these expressions, 
and copy/paste them into LiveMath Text Comments.
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And then copy/paste into LiveMath:
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You might want to get wild and create PDFs to copy/paste into 
LiveMath.   That won’t work with the current older-technology version 
of LiveMath on Mac (or Windows for that matter).  On the Mac, you 
will need to use Preview to copy/paste your PDF to first, which will 
convert the PDF to an older PICT-image.  On Windows you will do 
essentially the same, but using Paint. 

19.6  Drag & Drop Add To Graph

Screencast Video
http://www.livemath.com/v/1906

Drag & Drop Equations Onto Graph Theories
 
When you have a graph object, like this:

z x y=

2-2 x

-5

z00
0

5

2y-2
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you may wish to add another graphical object to this 3D graph: let’s 
say another surface plot.   The (new to LM 3.6) method is to simply 
drag your new equation onto the 3D graph:

 

      
And the result (after approving the variable-to-space coordinates 
dialog)

z x y=

2-2 x

-5

z00
0

5

2y-2

z 1 x 2 y 2+=

Let’s look inside of the Graph Details box to see what that Drag & 
Drop action did for us:



§ 19.6  Drag & Drop Add To Graph	  Page 623 

© 1999-2017 MathMonkeys, LLC.  © 1999-2017 Robert R. Curtis

z x y=

2-2 x

-5

z00
0

5

2y-2

  3− 3...  = west...east Stretch to Fit
  3− 3...  = south...north     cropped 

Moderately
  9− 9...  = bottom...top     as seen through a 

Normal  lens

Graph Building Blocks
 Surface at x y z, ,  where 
x west east...=  and 
y south north...= ; April Lighting
 surface has mesh  and is shaded using 
Solid  coloring;

White  is the solid color.
 Surface at x y z 1, ,  where 
x west east...=  and 
y south north...= ; Illuminated
 surface has mesh  and is shaded using 
Solid  coloring;

White  is the solid color.

z 1 x 2 y 2+=

We can see that a second SurfaceAt graphic primitive was placed 
inside of this 3D graph object, with the z 1 dependent variable in the 
z-coordinate slot.   You could now fine tune this new SurfaceAt object  
to a different color scheme, or different mesh setting, etc.  

Drag & Drop Comments Onto Graph Theories

The Drag & Drop feature attempts to figure out what you want to 
do with the drag, and tries to be as forgiving as it can be for novice 
mistakes.   

If you drag a Text Comment into Graph object, a copy of the Text 
Comment will be used to create a TagAt graphic primitive inside of 
the Graph object:
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The drag results in:  

z x y=

2-2 x

-5

z0
0

0

Saddle Surface

5

y 2-2

Saddle Surface

The drop point inside the graph is used to place the Comment, so if 
you drop the comment on the bottom left of the graph window, the 
TagAt is placed there (approximately, of course, in the 3D graph 
window case).   You may, of course, adjust the new TagAt graphic 
primitive to customize it as you like.   You may also have a text com-
ment with images inside of it - those, too, will get inserted into the 
TagAt text comment:
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z x y=

2-2 x

-5

z0
0

0

Saddle Surface

5

LiveMath rocks!y 2-2

Saddle Surface

LiveMath rocks!

Anything you can put inside of a Text Comment:  text, typeset expres-
sions, images - all of these can go inside of a live Graph object.

Remember that the text comment is copied into the Graph object at the 
time you make the Drag & Drop action.  If you change the Text Com-
ment later, the copy inside of the Graph object does not change with it.  

Drag & Drop Functions Onto Graph Theories

LiveMath is notoriously persnickity about how you graph a function 
f(x) or f(x,y).  Technically you should set up a function defined with a 
wildcard variable, and then create a dependent variable relation with 
the function, like this:
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f xxxxxxxxxxxxx xxxxxxxxxxxx sin xxxxxxxxxxxxx=
y f x=

0.5

1

1.5

y

-2 0 2x

With Drag & Drop, we loosened the rules a little bit.  So you could 
define a function g(x) and drag & drop that onto the 2D Graph object, 
and LiveMath will create the dependent variable relation for you:

Results in:
f xxxxxxxxxxxxx xxxxxxxxxxxx sin xxxxxxxxxxxxx=
y f x=

0.5

1

1.5

y

-2 0 2x
  3− 3...  = left...right      Stretch to Fit
  0 1.8...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where x left right...=  with a 

normal  line, colored Black .
 Curve at x g x,  where x left right...=

 with a heavy  line, colored Red .

g x x tan x−=
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Notice that LiveMath put the function actually in the y-coordinate spot 
in the CurveAt graphic primitive. You may be wondering:  how did 
LiveMath do that function call without wildcard variables?

Ahhhh.  LiveMath cheated for you a little.  Notice there is a little 
collapsar below the g(x) definition.  Let’s have a look:

f xxxxxxxxxxxxx xxxxxxxxxxxx sin xxxxxxxxxxxxx=
y f x=

0.5

1

1.5

y

-2 0 2x
  3− 3...  = left...right      Stretch to Fit
  0 1.8...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where x left right...=  with a 

normal  line, colored Black .
 Curve at x g x,  where x left right...=

 with a heavy  line, colored Red .

g x x tan x−=
g xxxxxxxxxxxxx tan xxxxxxxxxxxxx− xxxxxxxxxxxxx+=  Substitute

x xxxxxxxxxxxxx=

LiveMath did the standard trick of substituting 

x xxxxxxxxxxxxx=

into the regular variable definition of g(x) to create the wildcard 
defintion of g(x), and made a Hot Dot on that substitution Conclusion 
statement to make it the Working Definition of g(x).

We do this trick manually all the time.   The Drag & Drop mechanism 
does it for you, trying to save yourself from yourself.  

Drag & Drop Parametrics Onto Graph Theories

If you try to drag a 2-vector like this:
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You won’t get very far.  LiveMath will just go thud.   But put a nice 
dependent Matrix in a relation with that 2-vector, and you’ll be good to 
graph with Drag & Drop:

f xxxxxxxxxxxxx xxxxxxxxxxxx sin xxxxxxxxxxxxx=
y f x=

0.5

1

1.5

y

-2 0 2x
  3− 3...  = left...right      Stretch to Fit
  0 1.8...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where x left right...=  with a 

normal  line, colored Black .
 Curve at x g x,  where x left right...=

 with a heavy  line, colored Red .
 Curve at T  where t 3− 3...=  with a dotted

 line, colored Blue .

T t 2 t 3,=
g x x tan x−=

g xxxxxxxxxxxxx tan xxxxxxxxxxxxx− xxxxxxxxxxxxx+=  Substitute

x xxxxxxxxxxxxx=

There are limitations for what LiveMath will try to compensate for.
If that T vector has what looks to be 2 independent variables, then 
LiveMath will interpret that as a vector field plot request:
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0.5

1

1.5

y

-2 0 2x
  3− 3...  = left...right      Stretch to Fit
  0 1.8...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where x left right...=  with a 

normal  line, colored Black .
 Curve at x g x,  where x left right...=

 with a heavy  line, colored Red .
 Vector field filled normally  from t s,  size 

Medium  pointing towards T  where 
t left right...= s bottom top...=  with 
One variable-length arm  and an arrowhead

 colored Black .

T t 2 s t,=

Drag & Drop With Dependent Variables Onto Graph Theories

Usually LiveMath is very unforgiving with multiple dependent 
variables that are the same symbol - you can only Hot Dot one of the 
equations at a time - that is a fundamental construction (and power) of 
LiveMath:

y x sin x=
y x 2− 1+=

Same Dependent
Variable Symbols:   y

But when you Drag & Drop an equation that may have a dependent 
variable conflict with a previously graphed equation, LiveMath will 
compensate with the some trickery to try to save yourself from your-
self:  subscripts are introduced, and the subscripted equation is hidden 
under a collapsar of the original equation:
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y x 2− 1+=
y 1 y=
y 1 x 2− 1+=  Substitute

y f x=

0.5

1

1.5

y

-2 0 2x

  3− 3...  = left...right      Stretch to Fit
  0 1.8...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where x left right...=  with a 

normal  line, colored Black .
 Curve at x y 1,  where x left right...=  with a 

normal  line, colored Orange .

New Equations
with subscripts

and substitution
automatically

inserted
under collapsar

Drag & Drop

The reason:  this is what you would do yourself, manually, to get past 
the multiple dependent variable problem.   But for many of us, we just 
like to see graphing equations with a pure “y” dependent variable, 
without always having to go to subscripts or different letters.

Drag & Drop Points and Matrices Onto Graph Theories

You may also drag points and/or matrices to a graph window:

Drag & Drop

of a matrix of points:
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Drag & Drop

Make sure you have the dimensions correct!  Otherwise, LiveMath is 
not going to fix things up for you!

Drag & Drop One Graph Theory Onto Another Graph Theory

Sometimes you are building up a graph, and you want to get all of the 
(major) graphics primitives copied over to a new graph.   You may 
do this easily by Drag & Drop one Graph Theory onto another Graph 
Theory.

All of the major Graphics Primitives will be copied over to the new 
graph.

-2

0

2

y-2 0 2x

  3− 3...  = left...right      Stretch to Fit
  3− 3...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x x sin x 2,  where 
x left right...=  with a normal  line, colored 
Red .

 Scatter plot of 1.75− 0,  where ?? using 10 point 
spots  colored Blue .

 Curve at x 1
2 cos x 2−,  where 

x left right...=  with a extra heavy
 line, colored Dark Green .
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If you drag a 2D Graph onto a 3D graph, the 2D graph objects objects 
are copied over to the x-y plane (or the equivalent in that graph 
theory).

If you drag a 3D Graph onto a 2D Graph, all of the 3D graphics primi-
tives are squished to the x-y plane (simple coordinate projection).   

The minor graphics primitives are not copied over with this operation:  
Grid, Axis, nor any of the Name Declarations nor functional defini-
tions.   This would cause havoc is everything were copied over.  The 
goal of this operation is to quickly combine simple graphs together, not 
address every pathological example of specialized LiveMath program-
ming.

Drag & Drop Catalog 

Here is a complete listing of all Drag & Drop Add Graph actions

All Graphs

Drag Object Example Result
Point/Matrix X 1 2,= Scatter

Text Comment Text! Tag

Graph Theory
-2

0

2

y-2 0 2x

Major Primitives 
Adjusted for
Dimension

2D Graphs 

Drag Object Example Result
Function 

f : R1 →R1 f x x 2= CurveAt
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Function
f : R2 →R1 f x y, x 2 y 3= Contours

Function
f : R2 →R2 f x y, x y 2 x 2,= VectorField

Equation 2 Variables y x 2= CurveAt

Equation 3 Variables z x 2 y 2+= Contours

Equation 2-Vector T t 2 t 3,= Parametric Curve

Equation 3-Vector T t t 2 t 3, ,= Parametric Curve
Projected to x-y plane

Equation 2-Vector F s t t 2,= VectorField

Equation 3-Vector F s t s 2 t 2, ,= Contours of 
Parametric Surface

 3D Graphs 

Drag Object Example Result
Function 

f : R1 →R1 f x x 2= CurveAt 
in x-y plane

Function
f : R2 →R1 f x y, x 2 y 3= SurfaceAt

Function
f : R2 →R3 f x y, y x y x, ,= Parametric Surface

Function
f : R2 →R2 f x y, x y 2 x 2,= VectorField

in x-y plane
Function

f : R3 →R3 f x y z, , y 2 z 3 x, ,= VectorField

Equation 2 Variables y x 2= CurveAt
in x-y plane

Equation 3 Variables z x 2 y 2+= SurfaceAt
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Equation 2-Vector T t 2 t 3,= Parametric Curve
in x-y plane

Equation 3-Vector T t t 2 t 3, ,= Parametric Curve

Equation 2-Vector F s t t 2,= VectorField
in x-y plane

Equation 3-Vector F s t s 2 t 2, ,= Parametric Surface

19.7  Marks 

Screencast Video
http://www.livemath.com/v/1907

This little feature has been in place for many years, but hidden and 
undocumented.

If you type into a math assumption:  xVEC

You will magically get this:  x
The suffix VEC on the end of any Name Declaration gets magically 
transformed into a Vector mark.

Historically LiveMath “names” in Name Declarations (variables, 
functions, et al.) are strings of plain characters.  In order to preserve 
backwards compatibily with earlier minor releases of LiveMath 3.5, I 
adopted this suffix VEC trick to get marks onto the variable or func-
tion names;  if an older version of LiveMath opened a notebook with a  
x  that earlier version would simply see a xVEC as a variable name - a 
bit odd, but it would not crash nor cause a variable conflict.

You may put a VEC suffix on any Name in LiveMath, so here are some 
other examples:
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abcVEC     abc

LiveMathIsCoolVEC    LiveMathIsCool
The following suffices will give the corresponding marks:

xDOT x
xDDT x
xDDD x
xTIL x
xVEC x
xDVE x
xBAR x
xHAT x
xARC x
xBVE x
xDBA x

You may also make Marks using the menu command in the Insert 
menu:
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The No Mark menu item in this submenu will undo a mark.

Warning:  when you select and “x” and convert it into a xVEC  =  x
using the menu command, you are converting EVERY x in the current 
notebook into an xVEC  =  x  .   You are actually changing the Name 
Declaration that defines the name “x” into “xVEC  =  x ”.   So be 
careful!  If you change such a variable globally, and you didn’t really 
want to, just go find the Name Declaration and overtype over the 
xVEC  = x  just x - this will convert it back.  

You may also do marks in Text Comments areas as well.   

19.8  Print Page Preview and Improved Pagebreak Printing

Screencast Video
http://www.livemath.com/v/1908

Suppose you have a big LiveMath notebook, and you want to print it 
out (or output to PDF via the Print function, on the Mac with Save As 
PDF, and on Windows with PrimoPDF or some other tool).   

You may wish to fine-tune Page Break locations and other adjustments 
so that the final output is more appeasing.   
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To turn on Show Pagebreaks, select the menu item in the File menu:

Next, hold down the W on Mac or a on Windows, and you 
will see the page delimiters show up:

Actual Page Break

Would-be
Page Break

Width of
Current
Page

The red line shows where the page break would be, but in this example, 
the graph theory is in the way, so the page break needs to come before 
the graph theory.   

All of the calculations of page breaks are dependent upon the chosen 
printer and Page Setup dimensions.   In the example above, the Page 
Setup shows this:
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If we change the Scale to 65% instead, we will see the change in the 
Page Breaks:

Page
Break
Change

Width
Change

Scale Change: 100%           65%

I have this two part approach to showing these page delimiters because 
the calculations of these page cut-offs is very hard on the system: 
there are a lot of calculations going on, and you don’t want that heavy 
burden of calculations happening all the time - especially while you 
might be doing some drag calculations or something.   This is a limita-
tion of the older QuickDraw/Mac and GDI/Windows technologies.  
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19.9  Inequality Solving

Screencast Video
http://www.livemath.com/v/1909

A feature that was snuck in a few years ago as I wrote a Precalculus 
e-text was support for solving inequalities.   As a first example, start 
with:

5 x− 3+ 7>

With AutoSimplify OFF, you may complete this series of computa-
tions:

5 x− 3+ 7>
5 x− 7 3−>  Move Over

x 1
5 7 3−−<  Isolate

x 4
5−<  Simplify

You can do computations involving cases, similar to solving polyno-
mial equations:

x 2 2 x− 6+ 9>
x 2 2 x− 6+ 9− 0>  Move Over

x 2 2 x− 3− 0>  Simplify

x 3− x 1+ 0>  Factor

x 1+ 0>
x 0 1−>  Isolate

x 1−>  Simplify

x 3− 0 1
x 1+

>  Isolate

x 3− 0>  Simplify

x 0 3+>  Isolate

x 3>  Simplify

x 1+ 0<
x 0 1−<  Isolate

x 1−<  Simplify

x 3− 0 1
x 1+

<  Isolate

x 3− 0<  Simplify

x 0 3+<  Isolate

x 3<  Simplify
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Note that each Case Theory here has the assumption conditions at the 
top line, so the solutions are read off as:

		  x > –1 and x > 3   x > 3
		  x < –1 and x < 3   x < –1

We can see this solution also with one of the (graphing) Macros, in 
menu Compute ▶ Macros: Graphing ▶ Graph 1D Inequality   

-6 -4 -2 0 2 4 6x 0

You may also try inequalities with functions as well:

sin θ 1
2<

θ 2π n 2
1
6 π+<  Isolate

θ 11
6 π−<  Substitute

θ 5.7596−<  Calculate

θ 1
6 π<  Substitute

θ 0.5236<  Calculate

θ 13
6 π<  Substitute

θ 6.8068<  Calculate

n 2 1−=
n 2 0=
n 2 1=

θ 2π n 1
5
6 π+>  Isolate

θ 7
6 π−>  Substitute

θ 3.6652−>  Calculate

θ 5
6 π>  Substitute

θ 2.618>  Calculate

θ 17
6 π>  Substitute

θ 8.9012>  Calculate

n 1 1−=
n 1 0=
n 1 1=

-6 -4 -2 0 2 4 6θ 0

There are some other graphical solution Macros in the Compute ▶ 
Macros menu.
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19.10  Contour Plot Changes

Screencast Video

Sometime since the last major update, a few small changes were 
inserted into the Contour Plot primitive:

 Contours at ? where ? and ?; normally  spaced contours of ? computed with 
matching  resolution, shown in normal  line style, colored Red  with labels

Often Contour Plots need a higher amount of resolution (more points) 
to make their graphs smoother.   But if you have other graphic primi-
tives in the same Graph Theory, you don’t necessarily want those other 
primitives to have their resolution cranked up.   So Contour Plots may 
have matching resolutions to the Graph Theory, or you may change 
that popup menu to a different, independent setting.

It used to be that Contour Plots had only a single line style - now 
Contour Plots may have many different line styles, with Extra Heavy 
the most useful, especially in a complicated Graph Theory.   

It used to be that Contour Plots had only a fixed color: Black.  Now 
Contour Plots may have multiple colors like any other CurveAt plot.

Here is what Contour Plots could look like previously:
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-2

0

2

y-2 0 2x

  3− 3...  = left...right      Stretch to Fit
  3− 3...  = bottom...top    cropping Moderately

Graph Building Blocks
 Contours at x y,  where x left right...=  and 
y bottom top...= ; at zero only

 spaced contours of y 2 x 3 x 2+−  computed with 
matching  resolution, shown in normal

 line style, colored Black  with labels

And now with these new customizations:

-2

0

2

y-2 0 2x

  3− 3...  = left...right      Stretch to Fit
  3− 3...  = bottom...top    cropping Moderately

Graph Building Blocks
 Contours at x y,  where x left right...=  and 
y bottom top...= ; at zero only

 spaced contours of y 2 x 3 x 2+−  computed with 
highest  resolution, shown in extra heavy

 line style, colored Red  with labels

19.11  CurveAt & Grid Changes
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Screencast Video
http://www.livemath.com/v/1911

The ScatterPlot graphics primitive has long been able to have multiple 
parameters, like this:

0

2

4

6

8

10

y
0 2 4 6 8 10x

  1− 11...  = left...right      Stretch to Fit
  1− 11...  = bottom...top    cropping Moderately

Graph Building Blocks
 Scatter plot of a b,  where 
a 1 10...= b 1 10...=  using 7 point 
solid squares  colored Blue .

The Range object (2nd slot) can be multiple ranges, multiplied 
together.   You can, in fact, get crazy with more than just 2 independent 
ranges - just multiply another range.   In this way Scatter Plots are 
multidimensional.

I wanted the same kind of thing for the CurveAt graphic primitive.  I 
got tired of having to do this to graph a family of curves:  having to 
have 1 CurveAt graphic primitive for each different family. 
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-2

-1

0

1

2

y
-2 -1 0 1x

  2.1− 2...  = left...right      Stretch to Fit
  2.5− 2.6...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x x,  where x left right...=  with a 

normal  line, colored Red .

 Curve at x x 2,  where x left right...=  with a 
normal  line, colored Red .

 Curve at x x 3,  where x left right...=  with a 
normal  line, colored Red .

 Curve at x x 4,  where x left right...=  with a 
normal  line, colored Red .

I wanted the CurveAt command to be able to have an additional 
parameter.   So taking from the same construction that ScatterPlot has, 
you can now do this:

y x Int n=

-2

-1

0

1

2

y
-2 -1 0 1x

  2.1− 2...  = left...right      Stretch to Fit
  2.5− 2.6...  = bottom...top    cropping Moderately

Graph Building Blocks
 Curve at x y,  where 
x left right...= n 1 5...=  with a normal

 line, colored Red .

Be careful: Unlike Scatter Plot which is made for integers, these ranges 
in CurveAt do not increment on integers, which is why I have the Int(n) 
function there in the exponent.  
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This construction is not at all efficient!   Just the x 2 is computed 
multiple times!   The real solution to this problem is to have a Loop 
object that would work on integers, but that will have to wait for a 
future release.  For now, we have this little trick to get CurveAt primi-
tives to be able to have 2 independent parameters.

I did not want to make this feature crazy by having multiple parameters 
like ScatterPlot can handle, mainly because CurveAt is not going to 
be dealing with just integer loops, and CurveAt has a lot more going 
on with curve smoothing and refinements that just get out of hand 
with more than 1 extra parameter.   So 2 independent parameters is the 
maximum, for now.

Alternatively, you can use an improvement of the Grid graphic primi-
tive to accomplish the same, this time controlling your increment 
precisely:

-2

0

2

y-2 0 2x

  3− 3...  = left...right      Stretch to Fit
  3− 3...  = bottom...top    cropping Moderately

Graph Building Blocks
 Grid lines at x x n,  where x left right...=

 for each value n 1. 5...=  separated by 1 colored 
Red  with line style heavy

The addition to the Grid graphic primitive is the line style.  

 Grid lines at x x n,  where x left right...=
 for each value n 1. 5...=  separated by 1 colored 
Red  with line style heavy

New Line Style for Grid
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Historically, the Grid primitive has a “lightening” feature, in that it 
lowers the color intensity (mixes the color with more white), as you 
don’t want your grids on a graph to overwhelm the star of your show: 
the Curve and Surface and Contours. 

The “lightening” feature has been preserved when the Line Style is set 
to Normal, the historical setting under the hood.  When the Line Style 
is changed from Normal, the “lightening” is turned off, giving the full 
color.   Likely if you change the Line Style to Bold or Extra Bold on a 
Grid, you are not using the primitive just to draw grid lines, but rather 
using the double parameter feature to do something more.

19.12  Macros

Screencast Video
http://www.livemath.com/v/1912

The Macros area of the Compute Menu were designed to be semi-
automated constructions in LiveMath that you could do manually, but it 
would be a lot of work to do, and why not have a nice one-shot way of 
doing these constructions.

An excellent example is the Macro for Completing the Square, a 
standard algebraic computation in high school algebra.   For years, 
high school math teachers and students would write to me to ask, 
“Can LiveMath Complete The Square?”  The philosophy of LiveMath 
dictates that the answer should be, “Yes, of course, but you need to do 
it yourself!”
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But it seemed that we needed to step back from that philosophy a 
little bit, and help out with some calculations like this, rather than 
just telling wayward students (and teachers) “yes, but do it yourself”.   
These kinds of requests collected together to create the Macros menu 
area and functionality.

A typical problem in high school algebra of Completing the Square 
might start with this equation:

y x 2 3 x+=

Selecting this equation and then the menu Compute ▶ 
Macros: Algebraic ▶ Completing the Square gives us:
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y x 2 3 x+=

y 0− 3 1
2 1

2
1+ x 2 3 x+ 3 1

2 1
2
1+=  Complete Square

y 9
4+ x 2 3 x 9

4+ +=  Simplify Simplify

y 9
4+ x 3

2+
2=  Factor

y x 3
2+
2 9

4−=  Move Over

As you can see, all of the functionality shown in this computation 
exists in LiveMath already, so it is not like there is a new “function” 
called “Completing the Square” where the beginning equation is 
simply transformed to the final answer.  The idea of Macros was to 
show students (and others) the steps involved in doing this algebraic 
computation in LiveMath, that they could do on their own manually, 
or use the Macro to get a little help from LiveMath on the steps to 
complete.

Let’s look at each of the Macros menus a bit more in detail.

Macros: Arithmetic

The Rounding macros are rather obvious in their goal.  In the style 
of Macros, these options actually try to teach you how you would set 
up these functions in LiveMath manually:  a new function is defined, 
named “round”, that uses one of the predefined functions already built 
into LiveMath.

 A Function  named round  behaves as Round to nearest integer .
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13.5
round 13.5
round 13.5 14=  Calculate

The Factor Pairs menu was an interesting request from a teacher years 
ago:  to show all factorizations of a number, in factor pairs.

25 49
25 49 1225=  Simplify

25 49 1225 1=  Factor Pair

25 49 245 5=  Factor Pair

25 49 175 7=  Factor Pair

25 49 49 25=  Factor Pair

25 49 35 35=  Factor Pair

The Reduce Root helps a beginning in LiveMath deal with root simpli-
cation.  If you try to Simplify this square root:

175

Nothing will happen.   Simplify will not first factor the interior of 
the square root:  you should do that manually yourself, being a good 
mathematician.   But in case you just learning how LiveMath works, 
this Reduce Root macro will help you, and show you the process you 
should follow:

175
175 52 7=  Factor Root Base

175 5 7=  Expand

Rationalize Denominator is another computational process that users 
of LiveMath should do on their own, but the Macro helps you a little 
bit to get there:
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17
11
17
11

17 11
11 11

=  Multiply By One

17
11

17 11
11

=  Expand Expand

The Real and Imaginary Parts macros are similar to the Rounding mac-
ros:   in LiveMath you should define a function and apply that function 
to the object, using the built-in functions for Real and Imaginary parts.  
Here the “Re” function is created and defined:

 A Function  named Re  behaves as Real part .

19 7 i−
Re 19 7 i−
Re 19 7 i− 19=  Calculate

The Complex Conjugate computation should be something that 
LiveMath users do manually, but the Macro helps you this conclusion a 
little bit:

 A Function  named Conjugate  behaves as Complex Conjugate .

13 4 i−
Conjugate 13 4 i−
Conjugate 13 4 i− 13 4 i+=  Calculate

Macros: Solving

The original item in this menu from way back to LiveMath 3.0 was the 
Find Graph Root:  you have a 2D graph, then you adjust the graph 
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so that there is only 1 root (x-axis crossing) is showing, then enact 
Find Graph Root to have the root value spit out.

Solve By Factoring was made into a Macro because it is process that 
one must go through every time you solve a polynomial equation for 
its roots via factoring.   So the Solve By Factoring is just to save you 
some time drudging through the steps.

x 3 9 x 2 7 x− 2+ + 0=
x 0.36989− 0.26177 i− x 0.36989− 0.26177 i+ x 9.7398+ 0=  Factor

x 0.36989− 0.26177 i+ x 0.36989− 0.26177 i− x 9.7398+ 0=  Simplify

x 0.36989− 0.26177 i+ 0=  Isolate Each Monomial Factor

x 0.36989 0.26177 i−=  Isolate

x 0.36989− 0.26177 i− 0=  Isolate Each Monomial Factor

x 0.36989 0.26177 i+=  Isolate

x 9.7398+ 0=  Isolate Each Monomial Factor

x 9.7398−=  Isolate

Solve by Newton’s Method is macro that creates the SolveNewton 
function declaration

 A Function  named SolveNewton  behaves as SolveNewton .

x 3 9 x 2 7 x− 2+ + 0=
NewtonSeed 1=
x 0 SolveNewton x 3 9 x 2 7 x− 2+ + NewtonSeed 20, ,=  Solve By Newton’s Method

x 0 0.5663=  Calculate

The built-in function SolveNewton simply applies the Newton’s 
method iteration formula behind the scenes:

x n 1+ x n

f x n

f ′ x n

−=

Of course, you can do this formula manually in LiveMath as an intera-
tion activity (for students)
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f xxxxxxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxx 3 9 xxxxxxxxxxxxxxxxxxxxxxx 2 7 xxxxxxxxxxxxxxxxxxxxxxx− 2+ +=

f ′ xxxxxxxxxxxxxxxxxxxxxxx
xd
d f x

x xxxxxxxxxxxxxxxxxxxxxxx=
=

f ′ xxxxxxxxxxxxxxxxxxxxxxx 3 xxxxxxxxxxxxxxxxxxxxxxx 2 18 xxxxxxxxxxxxxxxxxxxxxxx 7−+=  Substitute

x 1 1=

x 2 x 1
f x 1

f ′ x 1
−=

x 2 0.64286=  Calculate

x 3 x 2
f x 2

f ′ x 2
−=

x 3 0.38731=  Calculate

x 4 x 3
f x 3

f ′ x 3
−=

x 4 1.2661−=  Calculate

x 5 x 4
f x 4

f ′ x 4
−=

x 5 0.33499−=  Calculate

Or using recursive functions you can set up this computation:

f xxxxxxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxx 3 9 xxxxxxxxxxxxxxxxxxxxxx 2 7 xxxxxxxxxxxxxxxxxxxxxxx− 2+ +=

f ′ xxxxxxxxxxxxxxxxxxxxxxx
xd
d f x

x xxxxxxxxxxxxxxxxxxxxxxx=
=

f ′ xxxxxxxxxxxxxxxxxxxxxxx 3 xxxxxxxxxxxxxxxxxxxxxxx 2 18 xxxxxxxxxxxxxxxxxxxxxxx 7−+=  Substitute

N nnnnnnnnnnnnnnnnnnnnnnn
N nnnnnnnnnnnnnnnnnnnnnnn 1− f N nnnnnnnnnnnnnnnnnnnnnnn 1−

f ′ N nnnnnnnnnnnnnnnnnnnnnnn 1−
− nnnnnnnnnnnnnnnnnnnnnnn 1>

1 nnnnnnnnnnnnnnnnnnnnnnn 1=
=

S N 2 N 3 N 4 N 5 N 6 N 7 N 8 N 9 N 10 N 11 N 12, , , , , , , , , ,=
S 0.64286 0.38731 1.2661− 0.33499− 0.08392 0.35394 3.0943 1.8525 1.1354 0.72406 0.45722, , , , , , , , , ,=  Calculate

As you can see, the Solve By Newton’s Method Macro saves you 
a lot of time and awkwardness - if you just want to get a numerical 
solution to an equation, you don’t necessarily want to set up all of these 
constructions just to get an answer!
Macros: Calculus

Some of the Macros in this area are actually full features previously 
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found in LiveMath 3.0, but now they have been moved into this sub-
category, since they really are “macros” in philosophy.   

Taylor Series will compute a Taylor expansion of a given function, as 
has been a long-standing feature.

Integration by Parts has been improved over the version 3.0 imple-
mentation:  instead of having to select the “dv” in the formula - as was 
the case with LiveMath 3.0 - you now select the easier-to-select “u” to 
initiate the integration by parts formula application: 

u d v
a

b
u va

b v d u
a

b
−=

x 2 sin x d x

x 2 sin x d x x 2 sin x d x sin x d x 2 x d x−=  Integrate by Parts

x 2 sin x d x x 2 cos x− 2 x cos x d x+=  Simplify

x 2 sin x d x x 2 cos x− 2 x cos x d x cos x d x d x−+=  Integrate by Parts

x 2 sin x d x x 2 cos x− 2 cos x x sin x++=  Simplify

x 2 sin x d x 2 cos x x sin x+ x 2 cos x−=  Simplify

x 2 sin x d x 2 cos x x 2 cos x− 2 x sin x+=  Expand

Integration via Substitution is a macro that is more educational 
(and time-saving) than anything, showing the standard trickery of 
u-substitution in a Macro:
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x e x 2− d x

x e x 2− d x 1
2 e u d u−

u x 2−=
=  Integrate by Substitution

x e x 2− d x 1
2

e x 2−

ln e
−=  Simplify

x e x 2− d x 1
2 e x 2−−=  Simplify

Limits Via Factoring in an educational macro to show students 
the process of computing a limit by first reducing the limit object by 
factoring (numerator and denominator), and seeking algebraic simplifi-
cation of these terms first before computing the limit:

x 2 5 x− 6+
x 2 4 x− 3+x 3

lim
→  

x 2 5 x− 6+
x 2 4 x− 3+x 3

lim
→  

x 3− x 2−
x 3− x 1−x 3

lim
→  =  Factor Over Reals Factor Over Reals

x 2 5 x− 6+
x 2 4 x− 3+x 3

lim
→  

x 2−
x 1−x 3

lim
→  =  Simplify

x 2 5 x− 6+
x 2 4 x− 3+x 3

lim
→  

3 2−
3 1−

=  Limit Via Substitution

x 2 5 x− 6+
x 2 4 x− 3+x 3

lim
→  

1
2=  Simplify

Limits via L’Hopital’s Rule simply applies the standard formula 
from calculus to compute limits via derivatives (and, at the heart of the 
calculation, Taylor expansions):
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sin x 2

x 2x 0
lim
→  

sin x 2

x 2x 0
lim
→  

2 cos x sin x
2 xx 0

lim
→  =  Limit Via L’Hopital’s Rule

sin x 2

x 2x 0
lim
→  

2 sin x 2− 2 cos x 2+
2x 0

lim
→  =  Limit Via L’Hopital’s Rule

sin x 2

x 2x 0
lim
→  

2 sin 0 2− 2 cos 0 2+
2

=  Limit Via Substitution

sin x 2

x 2x 0
lim
→  1=  Simplify

Macros: Graphing

These graphing macros build up a semi-complicated graph to show 
solutions graphically.

Graph Solutions of Equation f(x) = g(x) produces the following 
multifaceted graph:

x sin x cos 3 x 4−=
y 2 x sin x=  Grab Left-Hand-Side

y 3 cos 3 x 4−=  Grab Right-Hand-Side

-1

0

1

2

y 3-2 0 2x

y2

y3

Graph 1D Inequality shows the intervals of solutions of a single 
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variable inequality:

sin x cos x 2− 1
3>

-6 -4 -2 0 2 4 6x 0

Graph 2D Inequality shows graphically the solutions of an inequal-
ity involving 2 variables:

cos x 1− sin y 2+<

-6 -4 -2 0 2 4 6x 0

-6
-4
-2
0
2
4
6

y 0

Graph System of 2D Inequalities shows graphically the solutions 
of a 2x2 system of inequalities:

x y+ 1<
x y− 3>

-6 -4 -2 0 2 4 6x 0

-6
-4
-2
0
2
4
6

y 0

Macros: Lists
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These macros were created to facilitate the conversion of the 
Probability&Mathematica courseware from MathEverywhere, Inc. into 
LiveMath format.   

Union Lists

A 1 2,=
B 3 4,=
C

C 1 2 3 4, , ,=  Union List

Intersect Lists

A 2 4 6 8, , ,=
B 2 4 6 9, , ,=
C

C 2 4 6, ,=  Intersect Lists

XGivenY Lists collects all elements in X (with repeats) that are in Y.

X 2 3 4 2 4 3 3 4 2, , , , , , , ,=
Y 2 4 6 9, , ,=
C

C 2 2 2 4 4 4, , , , ,=  XGivenY Lists

Join Lists
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